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Measures for response and prevention of Targeted Attacks (Advanced Persistent
Threats)

If any system is suspected to be infected or any email account is subjected to
unauthorised access the following measures shall be considered.

l. Incident Response Measures:

1. Determine accounts accessed by foreign IPs and unauthorised IPs.

2. Determine computers/laptops and mobile devices used to access such affected
email accounts P

3. Isolate the same from network. Take forensic image of the same and preserve
for further analysis. Collect volatile evidence like memory dump also. -

4. Preserve all the logs of the network where affected systems are !ocated and
analyse the same "

5. Coliect email access logs of affected email account and determine unauthorised
access (IPs). -

6 Take backup of important data and ciean the suspected affected systems with
CD/ Pendrive and infected system should be booted through such aiternate
drive.

7. Share forensic image of the affected system alongwith analysis report and
actions taken at organisational end with CERT-In for further analysis.

il. Incident Prevention Measures:

» Block/ Restrict connectivity to the malicious domains /IPS shared by CERT-In from
time to time. If any of the machines found contacting them, take volatile evidence,
isolate the machine, start necessary mitigation and containment procedures. Take
forensics image of the machine for root-cause analysis. It is recommended that,
restore the system from a known good back up or proceed to a fresh installation.

. ____._* Keep up-to-date patches and fixes on_the operating system and application.

B _ software such as client side software’s, including Adobe Products (reader. flash
— — — players), Micresoft Office suites, browsers-&JAVA applications. Refer Appendix
e Restrict execution of powershell MWSCRIPT in enterprise environment Ensure
installation and use of the latest version (currently v5.0) of PowerShell, with
enhanced logging enabled. script block logging, and transcription enabled. Send

the associated logs to a centralized log repository for monitoring and analysis.

Reference:https:/iwww fireeye. com/bloglthreatresearchl2016/02/greater \nsnblhty
t.html — — —
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Disable macros in Microsoft Office products. Some Office products allow for the

disabling of macros that originate from outside of an organization and can provide

a hybrid approach when the organization depends on the legitimate use of macros.

For Wlndows specn‘tc settings can block macros originating from the Internet from
running.

Control outbound DNS access. Permit internal enterprise systems to only initiate
requests to, and receive responses from, approved enterprise DNS caching name
servers. Monitor DNS activity for potential indications of tunnelling and data
exfiltration, including reviewing DNS traffic for anomalies in query request
frequency and domain length, and activity to suspicious DNS servers. The dnscat2
tool alternates between CNAME, TXT, and MX records when it is operating.
Investigate abnormal amounts of these records going to the same second level
domain, or a group of second level domains.

Reference: https://lwww.us-cert.gov/ncas/alerts/TA15-240A
http://nvipubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-81-2.pdf
Deploy web and email filters on the network, Configure these devices to scan for
known bad domains, sources, and addresses; block these before receiving and
downloading messages. Scan all emails, aftachments, and downloads both on the
host and at the mail gateway with a reputable antivirus solution.

Deploy Microsoft's Enhanced mitigation Experienced ‘Toolkit (EMET) which
provides end node protection against zero day vulnerabilities and blocks and
prevents memary based attack approaches.
hite.//support. microsoft. com/kb/2458544

Detailed steps for EMET configuration are described in Appendix B.

Enhance the Microsoft Office security by disabling ActiveX controls, Macros,
Enabling Protect View, File Protection Settings. Steps for configurations are
mentioned in Appendix-C

Apply software Restriction policies appropriately. Disable running executables
from unconventional paths. Steps for configurations are detailed in Appendix-D
Protect against drive-by-downloads through controls such as Browser JS Guard
and Sandboxie (Refer Appendix-E)

Leverage Pretty Good Privacy in mail communications. Addutlonally advise the
users to encrypt / protect the sensitive documents stored in the internet facing
machines to avoid potential leakage |

Exercise caution when opening e-mail attachments even if the attachment is
expected and the sender appears to be known.

Scan for and remove suspicious e-mail attachments; ensure the scanned
attachment is its "true file type" (i.e. the extension matches the file header). Block
the attachments of file types,
"exetpifltm;aiurl|vb|vbe|scr|_reg|cer|pst|cr£:d[com]bat]dmdat]hipihta[js|wsf"
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Maintain up-to-date antivirus signatures and engines.

Restrict users' ability (permissions) to install and run unwanted software
applications.

Enforce a strong password policy and implement regular password changes.
Enable a personal firewall on workstations.

Disable unnecessary services on agency workstations and servers.

Exercise caution when using removable media (e.g. USB thumbdrives, external
drives, CDs, etc.).

Scan all software downloaded from the Internet prior to executing.

Maintain situational awareness of the latest threats; implement appropriate ACLs.

Ifl. Measures for enhancing security of ICT infrastructure

Define an appropriate network architecture including both the network perimeter,
any internal networks, and links with other organisations such as service providers
or partners. Manage the network perimeter by control access to ports, protocols
and applications by filtering and inspecting all traffic at the network perimeter to
ensure that only traffic which is required to support the business is being
exchanged. Control and manage all inbound and outbound network connections
and deploy technical controls to scan for malicious content.

Use firewalls to create a buffer zone between the Internet (and other untrusted
networks) and the networks used by the business. The firewall rule set should deny
traffic by default and a whitelist should be applied that only allows authorised
protocols, ports and applications to exchange data across the boundary. This will
reduce the exposure of systems to network based attacks. Employ effective
processes for managing changes to avoid workarounds.

Network Intrusion detection / prevention and other appropriate security devices
should be deployed and monitored by trained personnel. Alerts generated from the
devices should be thoroughly verified as most of them could be an imminent attack.

Follow the best practices defined in 1SO 27003 while designing and segregating
network resources

Execute Access to local operating system accounts with system-levgl
administrative rights is restricted to the maximum extent possible. Usage is
controlled, monitored, and only permitted for relevant activities such as software
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instailation and configuration, maintenance, and emergency activities. At all other
times, the Accounis are restricted from being accessed.

System hardening applies the security concept of “least privilege” to a system by
disabling features and services that are not required for normal system operations.
This process reduces the system capabilities, features, and protocols that a
malicious person may use during an attack. Attackers leverage genuine native
utilities available in the Operating systems to lateral movements and to make
. persistence. e e R

Regular check on the configuration changes and appropriate usage of
configuration and change management. In most cases, miscreants were
successful in making changes to critical monitoring devices to exciude certain
operations so as to hide their racks. Stringent change management policies on
Enterprise security devices such as Firewalls AV gateways, Mail servers, DNS
records, Active Directories and enforcing effective change control policies.

Baseline the regular activities of end-point devices and servers. Diligently identify
behaviours such as successful RDP connections/ SSH logins, new System
Services/ processes, new installed applications/ software's, new User account
Creations, command history, log in user history, network usages and changes in
system configurations, disabled AV, System Services ste.

The Critical servers are either made stand-alone or member of a dedicated secure
zone Active Directory forest to use either local authentication or a secure zone
dedicated authentication system (for example dedicated instance of
LDAP/RADIUS solutions) to protect the secure zone against compromise of the
enterprise central authentication systems including theft of authentication
credentials to avoid pass-the-hash and pass-the-token attacks.

Check for unnecessary connectivity towards Content Delivery Networks, as
malware are known to tunnel the connection towards these domains to hide their
traffic and towards DDNS / free top level domains. Examples publicvm.com,
linkpc.net, zzux.com, chickenkiller.com, crabdance.com, ignorelist.com,
jumpingcrab.com, moo.com, strangled.net, twilightparadox.com etc. Regular
auditing of the failed connection attempts from DNS logs, proxy logs and to
successful connection towards unknown domains. Some of the attacks use
unconventional usage of DNS queries to exhilarate/ interact with the attackers
[DNS TXT Records]

Deploy SysMon for windows systems. Microsoft Sysinternals Tool SysMaon, is able
to monitor and log system activity to the Windows Event Log. It can provide
information about process creations, network connections, and changes to file
creation time. By collecting the events it generates using Windows Event
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Collection or SIEM agents, and subsequently analyzing them, Network Defenders
and System “

Administrators can identify malicious or anomalous activity and understand how
intfruders and malware operate on their networks.s

« POWERSHELL LOGGING AND BEST PRACTICES

We have observed that malicious poweshell scripts successfully bypass security
devices by leveraging obfuscation and performing code injection on the fly TO
OTHER processes without dropping malicious code to disk, effectively granting
arbitrary code execution. PowerShell is integrated with the .NET Framework and
has full access to Component Object Model (COM) and Windows Management
Instrumentation (WMI) functionality and WinAPI's

PowerShell can be run locally or across the network through a feature known as
Windows Remote Management (WinRM . To facilitate the use of WinRM, remote
workstations and servers on which code is executed must have remoting
enabled. Microsoft Windows Server 2012 and newer Microsoft Windows
operating systems have remoting enabled by default.

Organizations should install latest version [V0.5}where possible due to the
superior logging capabilities provided over earlier versions[can consider disabling
the previous versions]

Powarshzll Best practices
=  PowerShell V.5 With Applocker And Device Guard
»  Execution of signed PowerSheli scripts only which ensures authenticity

and integrity

*» Log Poweshell activity and push to a centralised logging systems
for strict monitoring particularly activities related to “BITS transfer,
Scheduled Tasks, active directory, Group Policy, WinRM, Network
[firewall, Server Manager ,SMB share. Search for specific key words
such as Invoke-Mimikatz, Invoke-ReflectivePEInjection,
System.Runtime.InteropServices.MarshalAsAttribute,
Win32Functions.VirtualAllocEx.Invoke.

» PowerShell Constrained language mode/ PSLockDownPloicy to restrict
the usage of advanced features such as such as .NET and Windows
API calls and COM access ‘
https://blogs.technet. microsoft.com/kfalde/2017/01/20/pslockdownpolic
y-and-PowerShell-constrained-language-mode/
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» ltis strongly advised that these options be thoroughly be tested before
deployment. Legitimate scripts using these features may cease to

function.

References
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h'ttps:f/c_ious.H'm;:rq;sso'i’t.com.fanwué;fv:,-fir_eaaws/deviw-sect,n"it\//device_;
guard/introduction-to-device-g uard-virtualization-based-security-and-code-
integrity-policies

Device Guard on Windows 10 and Windows Server 2016 can be used to enforce
constrained language mode and application whitelisting by leveraging advanced
hardware features where supported.

hitps.//docs. microsgj_t_,:gg;MQ[L—,gl_es_;fg-jm__gg_s;y;:.fcievic:e-security@evice—

quard/introd uction-towdevjcQ:cluargf;\.!.im,ia!iza‘rion—baseci~securit\i-and—code
integrity-policies

Check for unrecognized tasks being registered in task scheduler using
"Schtasks /Query /FO LIST /"

Check for entries in BITS run "bitsadmin /list"

Check for unauthorised WMI instances being registered.
[https://msdn.microsoft.com/en-us/library/ﬁ647965.aspx]

Configure the following parameter in the registry on all PCs running Windows 7
(and up) and all the servers using Windows 2008R2, to prohibit storing
unencrypted passwords in RAM (which are usually leveraged by Mimikatz)
HKEY _ LOCAL _
MACHiNE/SYSTEM/CurrentControISet/Control/SecurityProvidersNVDigest/UseL
ogon

Credential=0

Prohibit any remote logon to the system (RDP, SMB, RPC) for local administrators.
We recommend that you use only Logon type 2 (interactive):
https:/ltechnet.microsoft.com/en-ie/library/cc?87567(v=ws.10).aspx. Block RDP
connections originating from untrusted external addresses unless an exception
exists; routinely review exceptions on a regular basis for validity.

Prohibit a standard local administrator with an 1D=500 (which is vulnerable pass-
the-hash attack). Add another administrator and install updates to protect against
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Pass the hash attacks:

Jin

Enforce =oplicaidon whitelisiing /sofiware Heolriction Policies on all endpoint

workstations. This will prevent malware droppers or unauthorized software from
gaining execution on endpoints. Leverage Group Policy / Applocker to strict
enforcing of applications running from %appdata%, %tmp%, %temp%,
%locatappdata%,%programdata%, ' '

Minimize and completely deny granting administrator privileges for users of local
PCs, especially for users who work with external information systems.

Use a different local Administrator account password on every node, which must
not match any domain administration credentials. If this rule is not
currently applied — change all the passwords, make them unique, long and
complex. Securely manage local Administrator passwords by using specialized
tools, such as Microsoft’s L.ocal Administrator Password Solution (LAPS).

Isolate hosts in the same VLAN, so that one workstation would not be able to gain
access to another one on network levels L2/3, and could access
shared network segments (printers, servers, etc.)

Provide timely updates of OS, antivirus software and other applications.

Configure the service accounts with the minimum set of permissions necessary for
them to function properly (with respect to logon type and
group membership). Strictly prohibit adding service accounts to the local
administrators group unless absolutely necessary.

Ensure the integrity of data, system and application software deployed on the
infrastructure servers,; introduce application whitelisting on
workstations. '

Deploy web and email filters on the network. Configure these devices to scan for
known bad domains, sources, and addresses; block these before
receiving and downloading messages. Scan all emails, attachments, and
downloads both on the host and at the mail gateway with a reputable
antivirus solution

Disable file and printer sharing services. If these services are required, use strong
passwords or Active Directory authentication.
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* Restrict the usage of USB devices in the sensitive zones, blocking access to
__ physical ports/ whitelist the known devices. ..

s Deploy effective enterprise asset management strategies to keep track of software
versions that are installed on all the devices.

— e Perform regularted-team / blue team exercises on the network to re-establish the
rules, configurations and policies.

e Conduct security audit as per the stipulated standards on regular basis. Services
of CERT-In empanelled auditors may be availed. (refer Cyber security Assurance
section on website of CERT-In ntics /fwwiw. cari-in.cra.in/

» Visit the website https://www.cyberswachhtakendra.gov.in/ for alerts on malware
threats, free bot removal tools and security best practices and resources.

Kkkkk
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Appendix A

Updats Microsofi Office softwars
» Turn on automatic updates appropriately for your OS.
e Manual update for QS /MS office.

Find the current version of the Microsoft Version

Open a command prompt and enter the command to find the office version stored from
registry

reg query "HKEY_CIL.ASSES_ROOTWord.Application\CurVer"

Parse the output to get the version number and match against the list of existing
Microsoft office versions to get the name of the version installed:

Version  Number | Version
from registry

15 Office 2013
14 Office 2010
12 Office 2007
11 Office 2003
10 Office XP

9 Office 2000
3 Office 98

I Office 97

» For office 2013, choose File > Account > Update Options > Update Now of WORD
menu.(applicable to all office applications)
e For office 2010, File > Help > Check for Updates.

e For 2007, select Microsoft Office Button N Word Options >Resources > Check for
Updates.
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Appendix B

i

Configuring EMET (Ennanced Mitigation Sxperiencs Toolkil)
EMET enables deploying and configuring security mitigation technologies that guard your

PC from exploits by diverting, terminating, blocking, and invalidating those actions and
techniques.

EMET can be downloaded from here.
http:/fMww.microsoft.com/en-us/download/details. aspx?id=437 14

EMET forces applications to use several key mitigations built into Windows including Data
Execution Prevention (DEP), Address Space Layout Randomization (ASLR), and
Structured Exception Handler Overwrite Protection (SEHOP). DEP prevents data from
executing and ASLR prevents malware from assembling its malicious activity from
(multiple and specific) memory locations assigned in the system’s memory. SEHOP
prevents malware from overwriting entries in the structured event handler and malicious
code referenced by that entry.

Details can be seen here:
https://technet.microsoft.com/en-us/security/jj653751

The basic and necessary configuration has been explained below:

@ ~ Erhanced MhEgaben Sxperience Tostiat - & pomE
i T i3k Profie hame: o, Windows Event L T
T Import FLE QuiccProfie biame: ki = s o5 &
- “::Jd e TS e ity = ; Z: Teay 1on (:;;)
o Export Pes Skin: Office 2013 - ||l ey warring =
File_ Configuration Syshem Setiings __ Repotting nfo
System Statur -1 Configure Applications C s : o s T
o § ’_l Configure speciﬁcapplicaljm 10 optin to the miigaliors f‘;‘.’"] [ -
ata Executionl  supportad by EMET. Additionaly, mitgatons can be indvidualy | Always On
enablad or disabled on & par application bass, A SO S
Structurmd Exet, (CTHHSHIETA) o Aways On -
. —
Addrags Space Layout Randamization (ASLR) @ Apgpilcation Opt In -
curment protestion status , A
Certificate Frust (Pinning} §SL certificates s Enabled -
Rirreng Processes .
Process ID | Process Name  |Running BT |~
=04 ATORdS2 - Adobe Aoabat Reader DC
7936 AcroRd32 - Adobe Acobat Reader DC
8352 " ApplicationFramerost - Application Frame best
2368 srmsve - Adobe Aobat Updste Servies .
7944 sudiodg running processes
7088 ‘dwome - Google Chroma T " ’ a
9320 chrame - Google Clreme
263 dhrome - Gaogle Chrome
6654 dhreme - Google Chroma
w88 dwome - Googls Chrome
4100 "dhrama S Google Chrome
8232 drame - Google Crrame
9508 chrome - Google Chrame:
9258 dvems -Googe Chrome

First pane is categorised onto FILE, CONFIGURATION, SYSTEMV_SETTINGS,
REPORTING, INFO sections.

« File sections allows to “Import” (Ctri+Shift+) or “Export” (Ctri+Shift+E)
« Configuration: access the “Application Configuration” window by clicking on “Apps”

(Ctri+Shift+A), and the “Certificate Trust Configuration” window by clicking on
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“Trust” (Ctrl+Shift+T). The certificate pinning is a recent feature introduced, where
in EMET adds additional checks during the certificate chain trust validation
process, with the goal to detect man-in-the-middle attacks over an encrypted
channel. Each time a certificate chain trust is built by Internet Explorer for a SSL
certificate while browsing to an HTTPS website, EMET will validate the end-entity
SSL cerificate and the Root CA that issued that certificate against the
corresponding pinning rule configured by the user.
e System Settings: apply a Quick Profile for the system, as well as select a Skin for
_EMETGUI

« Reporting: This group allows toggling the Reporting options. It is possible to

configure the reporting of EMET alerts granularly. When EMET detects an
exploitation attempt or a SSL certificate that violates one of the pinning rules, the
EMET Service can be configured to perform one or more actions: writing to the
Windows Event Log, display an alert to the user, and/or use the Early Warning
Program

¢ Help: resources, such as the Support Forums, and the User Guide (Ctrl+Shift+F1),
and to access to the EMET Privacy Statement. ‘

The middle pain specifies the current mitigation techniques & ss! certificates status. The
lower pain details the current running status of the processes and the details of the EMET
protections enabled.

it is advised to enable these options on workstation, [DEP > always ON, SEHOP>always
on, ASLR >Application Opt in, Certificate Pinning > Enabled]
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i LB 0.{ 3:' ii':j & Gl esplet Vi Preptols O At Detours @ rsd Appicaion %
Tt et Aptation AddWidoed fReweve  Sow Rl Show A -hudtardy i Borres Funciors L
Sdetsd Sdeced o Seibegs ! T« BGuceit O > el » vity  SerihOHicels r
b3 Oplinds Tekift ktcn Hugatn Setigs
vt m,é,_t“.,;,,z._.,,l Cigerme v Hea feldor ' - B
s - T deckiophindi @ Mome " Tpr ™
R - dia [lasquarens apple
ﬂ;’; = Lib sk _ [Mestca Sgeh
- . 9 A
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The recommended settings of the configuration wizard, adds protections for internet
Explorer, WordPad, Microsoft Office, Adobe Acrobat and Reader, and Oracle Java. It
also Configures EAF+ (Export Address table Access Filtering +) with Internet Explorer
with the Microsoft Trident engine, the Adobe Flash plugin, the Microsoft VML plugin, the
Microsoft VBScript engine, and the Microsoft JavaScript engine.

It configured to biock the Adobe Flash plugin from running in Microsoft Excel, PowerPoint,
and Word (largely seen in targeted attacks), and blocks the Oracle Java, Microsoft VML,
Microsoft MSXML 4.0, Windows Script Host Runtime, and Microsoft Scripting Runtime
plugins from running in Internet Explorer in websites not belonging to the Trusted Sites
or Intranet zones.

T - -
| i
EMET Configuration Wizard E
; I P
i [@} * Use Recommended Settings)
‘ -';Rese% existing application configuration settings i
J -.ﬁﬂxdd protections for Internet Explorer, WordPad, Micrazoft Office, Adobe Acrobat and Reader, and Orade Java .}
! i b i
. fﬁadd Certificate Trust rules for Micrasoft and other pepular onling services {Twitter, Facebook ard Yahoa!) i
| i
® Snable Reporiing threuah Wirdows Event Log, Tray Iwon, end Early Warning Program ‘ i
@ i1 Keep Existing Sattings i
i
; !t Ade Cartifioate Trust rules far Micresofl gniive s=rioss
l [ Enzble Barly Warning Srogram
|
|
i
|

| EMET Frivany Staswasnt

.;'5'*;
i
.
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Appendix-C

NS OFTICE best Security Fractices

1. Disable or prevent ActiveX controls in Microsoft Office Word Document from running
without prompting.
Click Office Button-> Word Options -> Trust center-> Trust Center Settings->
ActiveX Settings

I Trust Center } Sequrity & more

Resources Learn more abgut protecting yout privacy and securty from Microsoit Gifice Online.

biitrosoft Trustwothy Computing

Microsott Office Word Trust Center

The Trust Center contains secutity and privady settings, These settings help keep your cormputer
secure, We recommend that you do net change these sethings.

v

Trust Center

Trustad Publishers
i ActiveX Setiings for all Cffice Applications

Trusted Locations .
For AdweX contiols in documents not in a trusted locstion:

Add-ins (O Disable ail controls without notification
tveX Settings O Prompt me befors enabling Unsafe for Initialization [UFY controls with additional pestrictions and Safe for
Activex Seflings | Initéalization (SFT) controiz with minimal restrictions
Macro Settings © Prompt me before enabling all controls with minimal restrictions
) Enabie ali controls without rastrictions and wiihout prompting Mot recommended; potentially dangerous controls
liessage Bar can runj

Privacy Cptions

Sare mode {helps limit the contiols access to your compurter)

For more details, visit
Iitto://ologs.technet.com/b/srd/archive/2012/04/10/ms12-027-enhanced-nrotections-
regarding-activex-controls-in-microsoft-office-documenis. asbx

2. Disable Macros in Microsoft Office Word documents.

Office Button-> Word Options -> Trust center-> Trust Center Settings-> Macros
Settings

Trust Center i Security & more . _ :

Laarn more about prote cting your priva ¢y and security from Microsoft Office Online.

Resources

Micra=oft Trustwa thy Computing

Migosoit Office Word Trust Center

The Trust Center contains secutity and privacy settings. Thes ¢ seitings nelp keep your computer -
secure, We recommend that you do not change these settings, Trust Center Settings... i
Trust Centter iz

Trusted Publishers

Madro Settings

Trustad Locations . . .
For macres in gocuments not in a trusted location:

Add.ins ©) Disable all macros without notification
netivex Setting © Disable all macros with notification
A ings
¢ Disable all macros except digitally signed macros

Macro Settings ! <_» Enable all macros (not cecommanded; potentially dangerous tode an run}

klassage Bar

Developer Macro Settings
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3. Configure built in “File Protection Setting” feature in Microsoft office 2010
-————Office Button-> Word Options -> Trust center-> Trust Center Settings->

R ROTTINTH 7Y

Filz Type

Addtins Word 2007 and later Dacuments and Tempiates
¢ AcliveX Settings DpenDocument Text Fiizs

Word 2007 and fater Binary Documents and Tempiates
“Narg 2003 Binary Documents and Templates
Protectad WNavy Waord 2003 and Plain XKL Dacuments

Word XP Binary Documents and Templates

‘Ward 2002 Binary Documents znd Tempiates

Word 97 Binary Documents and Templates

Ward 95 Binary Documents and Tempiates

Word 8.0 Binary Docyments 2nd Templates

VWard 2 and eadier Binary Documants and Tempiates
\Yab Pagas

PIF Files

Flain Text Fiizg

Legracy Converters for \Word

Ofice Dpen Xk Conyerters for Waord

Llacro Sattings

Ltessage Bar

Dpen | Save
O 0
O O
O O
O

O [m]
O

O

O

o [m}
o a
m} o}
O ]
O ]

QOpen b!ha\ria-r_lor seiecied Ale pes:
) Do ot open stiactad fia type<
@ Qpen seleczd file hpes in Proteded Viewr
) Open selected il ypes in Protacted Vievs and allosy gditing

4. Configure built in feature for “Protected View” settings in Microsoft Office 2010 to
open the Microsoft Office word documents in Protected view:

Office Button-> Word Options -> Trust center-> Trust Center Settings-

>Protected View

Trust Center i
t
|
l

Edigrosoft Windsoyyg Security Cente
Rlicrosaft Trustrorthy Computing

v

Wicrosaft Wared Trust Center

sacure, We recommend that you do not change these sattings,

Thz Teust Center cantaing seturity and privacy setings, These satlings help keep your computer

'l Trusted Publishers

Protected View

Trustad Lacations

Trusted Dozuments

1Iecsage Bar

File Bigek Settings

=i " = Privac; Options

Protected Viaw opens potentlally dangeraus fiies, withaut any secusity prompis, in & resteittad mods ta heip minimize ham |
o your computer. By disabling Protectza View you fouid be £xpasing your computerto possfbie security threats.

Enablz Protected View for files griginating from the Internat

Addins Enablz Protected View 107 files 1ocatad In potentiatly unsafe tacations i
ActiveX Settings Enable Protectad View for Outigok sttachments it
: Fzae Settings Data Fxecution Prevention

| Protecied View Enabiz Data Execution Prevention mode i
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slleaie resiiction policles (SR window s 7

Type secpol.msc from command prompt, under Software Restriction Policy
section, select Additional Rules- > New path rule.

Path if using Windows XP: %UserProfile%\Local Settings\*.exe
Path if using Windows Vista/7/8: %LocalAppData%\*.exe

Security Level: Disallowed
Description: Don't aliow executables to run from %AppData%.

= L .ISV . ”P.:-)I" ) i e e S ST TN I 1 P =S 1
%mﬂ ecurtty Policy Newr Path Rule l%
File Action View Help ] !
rHiaEBlEEE 1| | serer
% ;g:tgusnitgzlg:;es E%a;i % Use nules to ovemide the defauit securily level,
v [ Lacal Policies 259
= {3 Windows Firewall with Advan a1 R Y
10 Network List Manager Policies %localappdata®%y’.exe !
¢ 1 Public Key Policies ] " J I
4 [} Sofaware Restriction Policies Drowss.
2 Security Levels )
23 Additional Rules- s~
v {71 Application Coniral Policies ; @??‘a”ﬂ."‘f’?d | . b
¢ & 1P Security Policies on Local €
t . Advanced Audit Policy Config Description:
dnt fetmalware run fiom foca app “
Learmn mpre =bout sofiirare resiictipn policies
<[ W — e :
i OK i L Cancel ] LAPpIy

Fig: blocking executables running from %local appdata%

Note: this setting universally prevents exe’s running from the said location. This can

selectively opted-out by specifying the legitimate application path and give the security
level as unrestricted.
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Browser JSGuard

This tool is a browser extension which detects and defends malicious HTML &
JavaScript attacks made through the web browser based on Heuristics. it alerts the user
on visiting any malicious web pages and provides the detailed analysis threat report of
the web page. For more details, see below:

nitosdledac. in/index.asox?id=cs_sos BrowserdSGuard

Download Links:
For Firefox Web Browser:

https://addons.moziila.org/en-USIﬁrefox/addon/browser—jsguard/
For Google Chrome Web Browser:

https://ch rome.google.com/webstore/detail/browserjsguard/ncpkigeklakapceIcegambndi
hkcbhb

Sandboxing your Browser

A program called Sandboxie ( hitp://iwww.sandboxie.com/ ) which applies the sandbox
security concept to protect any browser.

Sandboxie makes surfing the web really secure and safe. You can always be relaxed and
be sure that no malware can infect your system. Also, while surfing, various emporary
files, cookies, cache, etc, are created and downloaded to the computer. Ali the
aforementioned remain inside Sandboxie and can be easily cleaned by deleting the
Sandboxie contents, and without worrying about where to look for them on your computer.
Just one click to deiete the Sandboxie contents, and it's ail gone.
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Basically, the protected browser is made to look within a small directory, but it thinks that
that directory is drive C. Sandboxie, and any sandbox in general, does not aim to prevent
an attack, but instead contains the attack, within that directory. If the attack creates folders
and files, it will be created in that directory. If it installs hacking tools and malware, they
will ali be confined to that directory. All your downloads will also arrive into that directory
first, and Sandboxie will help move it back to the outside world. And everything in that
directory can be wiped away with one click. In the Unix world, the conceptis called chroot,
and is traditionally used to prevent compromised server services from affecting the rest
of the system. This program is vital to securing your browser. The main use of
Sandboxie is for surfing the web where it keeps the browser isolated, and the system

remains safe from various malware infections.
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Right click on the sandbox and choose Sandbox Settings.

delete->delete invocation> checkmark automatically delete contents of sandbox
so that anything that gets into sandbox does not persist on your system

program stop->leader programs> < your preferred browser>
so that anything that gets into this sandbox get terminated when chrome exits
restrictions->Internet ~ access> <or your preferred browser>
so that anything that malware drops onto the system cant access
restrictions->start/run access> <your preferred browser>

restrictions->drop rights> checkmark 'drop rights ..."

&k dedek
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